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Overview 

What It Does 
The QuickBooks® Add-On adds to ProductCart the ability to export order information in an organized, 
time-saving manner to the popular accounting package published by Intuit. For more information about 
QuickBooks, visit: http://quickbooks.intuit.com/

By allowing you to import the Chart of Accounts, Item List and Customer List from your QuickBooks 
company file, the QuickBooks Add-on can help you synchronize product and customer information 
between your online store and your accounting package, thus ensuring that order data is correctly assigned 
to the proper accounts when exported from ProductCart and imported into QuickBooks. 

When designing this Add-on, Early Impact took into account a variety of scenarios based on whether you 
have a new or existing ProductCart store, and a new or existing QuickBooks company file. Depending on 
your scenario, a recommended setup procedure will be presented. 

What It Doesn’t Do 
At Early Impact we believe that it is very important to set the right expectations from the first moment 
someone starts using one of our software products. This is exactly the purpose of this section, which is 
meant to clarify the fact that the QuickBooks® Add-On does not automatically synchronize your 
QuickBooks company file with your online store. 

Specifically, please note that… 

• You will have to manually synchronize customer accounts, when and if needed. 
If you want an order placed by customer XYZ to be assigned to customer XYZ in your 
QuickBooks company file, you will have to manually map these two customer accounts. 
Although this can very easily be done with the QuickBooks Add-on, you should note that this 
task is manually performed for each account. Therefore, it can be time consuming if the number 
of customer accounts that need to be synchronized is high. 
 

However, in most cases this task will not be necessary. Most companies do not maintain different 
customer accounts in their QuickBooks company file for orders placed over the Internet, just like 
a retail store does not normally keep a separate customer account in their accounting file for each 
walk-in customer, but rather assigns those sales to a generic account (e.g. “Store Sales”).. 
 

If there are customers that you track individually in your accounting file (e.g. resellers, distributors, 
preferred customers, etc.), then you can map those customers to corresponding accounts in your 
ProductCart database (if they exist and if those customer buy online), and assign any other 
customer to a generic customer account. This can make this task much quicker to complete. You 
will learn more about importing and synchronizing customers later in this User Guide. 

• You may have to manually synchronize product accounts. 
Let’s assume your store database contains 100 products and that your QuickBooks’ Item List 
contains 200 items (i.e. not all of your products and services are sold online). How can you make 
sure that product information contained in orders that are exported from ProductCart into 
QuickBooks will match the corresponding items in your Item List? You have three options: 

o Map Individual Products. The QuickBooks Add-on Setup Wizard will guide you 
through a series of steps during which you will import your Item List into ProductCart. 
After importing your Item List, you will be able to map individual items to individual 
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products in your ProductCart store. Although time consuming, this is certainly a way to 
make sure that products and items are correctly synchronized. 

o Auto-Map Products. When you import your Item List into ProductCart, the system will 
try to automatically find matches for the imported items. ProductCart will compare the 
QuickBooks’ Description field for each of the imported items with the name of each of the 
products that are already in your store database. If it finds a match, it will map that item to 
the corresponding product for you. 
 

Note that if you export products from ProductCart to QuickBooks to create a new Item 
List (i.e. this is a new QuickBooks company file and so the Item List is empty), when you 
import the Item List back into ProductCart, all products will be automatically mapped as 
their names will match by definition. This is definitely the recommended course of action 
if you don’t currently have product information stored in your QuickBooks company file. 
You can at once populate the Item List and map all the items to the products stored in 
your ProductCart database. 

o No (or Partial) Product Mappings. Assume you import your Item List into ProductCart 
and the auto mapping feature does not find any matches (or only a few matches). As 
mentioned above, you can decide to individually map the remaining products, which 
ensures that when orders are exported to ProductCart, each product will be correctly 
matched to the corresponding item in the Item List when creating invoices or sales 
receipts. 
 

However, if you are dealing with a large number of products, manually mapping each of 
them may be too time consuming. In this scenario, ProductCart will ask you to assign all 
of these products to an income account from your imported Chart of Accounts. When these 
products are exported to QuickBooks as part of an order, they will be matched to existing 
items. If no match is found, a new item will be created. The new item will be assigned to 
the income account mentioned above. 

• You will have to manually export orders, whenever you wish to do so. 
When new orders are placed on your store, they will not be automatically exported to your 
QuickBooks company file. In other words, the QuickBooks Add-on does not create a “live” link 
between your store and your accounting software. However, once the QuickBooks Add-on has 
been setup and you have become familiar with it, exporting the latest orders from ProductCart 
into QuickBooks will only take a few moments. 

Glossary 
Please note the following definitions: 

• Products: The products and services that you are selling on your ProductCart-powered Internet 
store and that have been added to the ProductCart database. 

• Items: The products and services listed in your QuickBooks Item List. 
• Miscellaneous Items: Other miscellaneous entries listed in your QuickBooks Item List that are 

relevant to orders exported from ProductCart. For example: shipping and handling charges, 
payment fees, discounts, etc. 

• Accounts: Entries in your QuickBooks Chart of Accounts. 
• Customers: Customer information stored in your ProductCart database. 
• Customer Accounts: Customer information stored in your QuickBooks company file. 
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System Requirements 
In order to install the QuickBooks Add-On, your store must be running ProductCart. 

Although we always recommend that you are running the latest version of ProductCart, the QuickBooks 
Add-on will work with earlier versions of our shopping cart software. We recommend that you are 
running ProductCart v2.5 and above. 

Thanks to the fact that this Add-on does not overwrite any files in your store, there will be no file conflicts 
when you install the QuickBooks Add-on. Therefore, you do not have to worry about modifications that 
might have been made to your installation of ProductCart. 

License Terms 
A license to use the ProductCart QuickBooks Add-On can be purchased from the Early Impact software 
store. The QuickBooks Add-on is licensed on a per-store basis: each implementation of the QuickBooks 
Add-on requires a previous or concurrent purchase of a ProductCart license. Each license is granted 
according to the terms of the ProductCart End User License Agreement, which can be found in Chapter 
1 of the ProductCart User Guide. 

Source Code Editing Rights 
You have the rights to make changes to ProductCart’s source code within the terms of the End User 
License Agreement, which can be found in Chapter 1 of the ProductCart User Guide. 

About Early Impact 
Early Impact is a software development company focused on delivering powerful, yet user-friendly 
electronic commerce applications to small- and medium-sized businesses. Early Impact’s goal is to build 
unique, cutting-edge e-commerce software that allows businesses to effectively use the Internet as a sales 
channel for their products and services. 

Founded in 2001, Early Impact is a Limited Liability Corporation (LLC), privately owned and 
headquartered in San Francisco, California. For more information, please visit the company’s Web site 
located at: http://www.earlyimpact.com  

Copyright Information 
Copyright © 2001-2005 Early Impact, LLC. All rights reserved. 

ProductCart® is a registered mark of Early Impact, LLC. 

ProductCart, its source code and graphical interface, the ProductCart logo, this document, Early Impact, 
the Early Impact logo are property of Early Impact, LLC and are protected by US and International 
copyright laws. 

Except as permitted under the Copyright Act of 1976, no part of this document may be reproduced or 
distributed in any form or by any means, or stored in a database or retrieval system, without the prior 
written permission of Early Impact, LLC. 
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Step 1 – Configuring QuickBooks 

Overview 
Before you can start using the QuickBooks Add-on and successfully import orders from your 
ProductCart-powered store into QuickBooks, there are a few steps that need to be taken to make sure 
that data exported from ProductCart will find a proper match. Please carefully review the following 
paragraphs. You will be asked to confirm that certain items exist in your QuickBooks Item List, or create 
new ones. 

If you are new to QuickBooks and have not yet setup your company file, that’s where you need to start. 
So let’s begin with a few instructions on how to do so. If you have been using QuickBooks, you don’t 
need to create a new company and you can skip the next section. 

Note that this User Guide was written using QuickBooks Pro 2004 as a reference. Menu items and feature 
names used in this document may be different in earlier or more recent version of QuickBooks. We 
apologize for the inconvenience that this may create. 

Creating a New Company 
To create a new company file in QuickBooks, start the application and click on Create a New Company. 
QuickBooks’ EasyStep Interview will take you through several, intuitive screens in which you will be asked to 
provide general company information. Simply follow the instructions on the screen as you fill out 
information about your company’s name, address, basic tax information, and more. 

Here are a few things to note as you answer questions during the EasyStep interview: 

• Select type of business – Unless one of the selections from the list is a direct match to your 
particular business, we recommend that you select: Retail: General. After this step, 
QuickBooks will create your company’s data file. 

• Income and Expense Accounts. You will be presented a predefined list of income and expense 
accounts, which is partially based on the type of business that you chose in the previous step. 
If you are unsure which accounts you will need or not need, then accept the default settings. 
You can always add, edit or remove accounts at a later time. 

• Preferences. When going through the third section of the EasyStep interview, please note the 
following: 

o Sales Tax. Select Yes. The sales tax option must be turned on in QuickBooks before 
importing orders from ProductCart, even if you do not collect sales tax in your 
business. 

o Sales Tax Information 
 Single or multiple sales tax. In most cases, you’ll select the first option. 
 Enter a short name for the sales tax. E.g. “State Tax”.  
 Enter a sales tax description to be printed on invoices. E.g. “Sales Tax” 
 Enter the name of the government agency to which you pay sales tax. E.g. “State Board 

of Equalization” 
 
Complete the rest of the interview by following the instructions on the screen. When you are done, skip 
the next section and go to the section entitled Adding Necessary Items to the QuickBooks Item List. 
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Editing an Existing Company 
If you have just created a new company file, skip this section. If you are using an existing company file, 
note that even if you don’t charge sales taxes, your company file has to be setup to allow for sales taxes. 
To check that this is the case, open your QuickBooks company and select Preferences from the Edit menu. 
From the left-side navigation, select Sales Tax. On the window that appears, click on the Company Preferences 
tab. Look at the following settings: 

• Do You Charge Sales Tax?. Select Yes. The sales tax option must be turned on in QuickBooks 
before importing orders from ProductCart, even if you do not collect sales tax in your 
business. 

• Sales Tax Items. Make sure you have at list one item listed in the drop-down menu (e.g. “Sales 
Tax”).  

 

Adding Necessary Items to the QuickBooks Item List 
The next step is to review your existing Item List to make sure that a number of required items are listed. It 
is important to set up the following items in QuickBooks prior to using the ProductCart QuickBooks 
Add-On. This is true regardless of whether you just created a brand-new company file or are using an 
existing company file. 

Carefully review each of the following items. Your QuickBooks company file must contain a separate item 
for each of the following. All of these items must belong to income accounts in your Chart of Accounts. If 
any of the following do not exist in your QuickBooks company file, add them now.  

The actual item names (Item Name/Number field) can be different from the ones listed below, but the Item 
Type must be the one specified, and the Account must always be an income account. 

Shipping Charges 
Does you company file already have an Item in the Item List that is used for shipping or delivery 
charges? If yes, make sure that it has the properties listed below, and then skip to the next item. If 
no, add it now by following these instructions: 

• Select Item from the Icon Bar or Item List from the Lists menu. 
• Click on the Item button at the bottom of the page and select New. 
• As the Item Type, select: “Other Charge”. 
• As the Item name/Number, enter “Shipping Charges”. 
• As the Description you may enter anything you wish. 
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• Leave the Amount field set to 0. 
• Under Tax Code, specify whether this item is taxable or not. Shipping charges are often non-

taxable. 
• As the Account, make sure to select an income account. For example, by default QuickBooks 

creates an account named Sales: Shipping and Handling. If this account doesn’t exist, either use 
another income account or add it to your Chart of Accounts by selecting <Add New> from the 
Account drop-down on the New Item window. 

 
Handling Fees 
Does you company file already have an Item in the Item List that is used for handling fees? If yes, 
make sure that it has the properties listed below and then skip to the next item. If no, add it now by 
following these instructions. As you know, in ProductCart handling fees can be calculated separately 
from shipping charges, and therefore you need a separate account in your QuickBooks company file. 

• Select Item from the Icon Bar or Item List from the Lists menu. 
• Click on the Item button at the bottom of the page and select New. 
• As the Item Type, select: “Other Charge”. 
• As the Item name/Number, enter “Handling Fees”. 
• As the Description you may enter anything you wish. 
• Leave the Amount field set to 0. 
• Under Tax Code, specify whether this item is taxable or not. Handling fees are typically taxed. 
• As the Account, make sure to select an income account. For example, by default QuickBooks 

creates an account named Sales: Shipping and Handling. If this account doesn’t exist, either use 
another income account or add it to your Chart of Accounts by selecting <Add New> from the 
Account drop-down on the New Item window. 

 
Rewards Points 
Does you company file already have an Item in the Item List that is used for Reward Points (which 
might be named differently in your store)? If yes, make sure that it has the properties listed below 
and then skip to the next item. If no, add it now by following these instructions: 

• Select Item from the Icon Bar or Item List from the Lists menu. 
• Click on the Item button at the bottom of the page and select New. 
• As the Item Type, select: “Discount”. 
• As the Item name/Number, enter “Reward Points” or the name you use for Reward Points on 

your online store. 
• As the Description you may enter anything you wish. 
• Leave the Amount field set to 0. 
• As the Account, make sure to select an income account. For example, by default QuickBooks 

creates an account named Sales: Discounts Given (or Sales Discounts and Allowances). If this 
account doesn’t exist, either use another income account or add it to your Chart of Accounts 
by selecting <Add New> from the Account drop-down on the New Item window. 

• Under Tax Code, enter Tax as the discount is given before tax. 
 
Discounts/Gift Certificates 
Does you company file already have an Item in the Item List that is used for discounts and/or gift 
certificates? If yes, make sure that it has the properties listed below and then skip to the next item. If 
no, add it now by following these instructions: 

• Select Item from the Icon Bar or Item List from the Lists menu. 
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• Click on the Item button at the bottom of the page and select New. 
• As the Item Type, select: “Discount”. 
• As the Item name/Number, enter “Discounts/Gift Certificates”. 
• As the Description you may enter anything you wish. 
• Leave the Amount field set to 0. 
• As the Account, make sure to select an income account. For example, by default QuickBooks 

creates an account named Sales: Discounts Given (or Sales Discounts and Allowances). If this 
account doesn’t exist, either use another income account or add it to your Chart of Accounts 
by selecting <Add New> from the Account drop-down on the New Item window. 

• Under Tax Code, enter Tax as the discount is given before tax. 
 
Payment/Processing Fees 
Does you company file already have an Item in the Item List that is used for payment and/or 
processing fees? If yes, make sure that it has the properties listed below and then skip to the next 
item. If no, add it now by following these instructions: 

• Select Item from the Icon Bar or Item List from the Lists menu. 
• Click on the Item button at the bottom of the page and select New. 
• As the Item Type, select: “Other Charge”. 
• As the Item name/Number, enter “Payment/Processing Fees”. 
• As the Description you may enter anything you wish. 
• Leave the Amount field set to 0. 
• Under Tax Code, specify whether this item is taxable or not. Payment fees are typically taxed. 
• As the Account, make sure to select an income account. For example, by default QuickBooks 

creates an account named Other Income. Of course, you could separately create a new income 
account called “Payment and Processing Fees” or alike and reassign this item to it. 
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Step 2 – Installation 

Transferring the files to your Web server 
Installing the ProductCart QuickBooks Add-on is very easy. The following assumes that you have 
installed and activated ProductCart on your Web server. If you haven’t done so, perform the ProductCart 
installation as described in the ProductCart User Guide, and then continue with the instructions below. 

Download the latest copy of the ProductCart QuickBooks Add-on from the Early Impact Web site. A 
link to the file will be provided by Early Impact as soon as your purchase is determined to be legitimate. 
Due to the high rate of fraudulent orders that a software company like Early Impact receives, we have to 
personally verify each order. Typically this takes less than an hour, but it may take longer during a 
weekend or on a holiday 

If you purchased the software from an Early Impact reseller, you should have been provided a download 
link by the reseller, or the reseller may perform the installation for you. 

All ProductCart QuickBooks Add-on files are contained in a compressed (*.zip) file. Download and 
“unzip” the file on your local computer using your favorite unzip utility. If you don’t have an unzip utility, 
you can download a popular one at the following address: http://www.winzip.com/  

Once you have unzipped the file you will notice that it contains two folders: one called Standard or Parent 
Paths Enabled, the other one called Parent Path Disabled. They both contain a subfolder called ProductCart. 
The ProductCart folder contains all the files that you need to upload to your Web server to add the 
QuickBooks Add-on’s features to ProductCart. You will use one ProductCart folder or the other depending 
on whether you are using the Parent Paths Enabled (more likely) or Disabled (less likely) version of 
ProductCart. 

For more information about running ProductCart on a server with Parent Paths disabled, please refer to 
Appendix H of the ProductCart User Guide 

The productcart folder contains one subfolder, called pcadmin. This means that all the files that are part of the 
QuickBooks Add-on have to be uploaded to your administration folder, which by default is called pcadmin, 
but that you have very likely renamed following our security recommendations. If you have not renamed 
the pcadmin folder, this is certainly a good time to do so as renaming the folder makes it impossible for a 
hacker to locate your Control Panel login page, thus reducing the chances that an authorized user would 
try to access your Control Panel. For more information on performing this task, please refer to the 
ProductCart User Guide. 

Use your favorite FTP program to upload all the files to the pcadmin folder (again, this folder has very 
likely been renamed with a unique name in your ProductCart installation). You will be uploading 25 files 
(this number may have changed slightly in your version of the QuickBooks Add-on) and two new folders 
used to store data that is imported from QuickBooks (qbk_import folder) or exported from ProductCart 
(qbk_export folder). None of these files will overwrite any of the existing files. Therefore, you can install 
the QuickBooks Add-on without having to worry about possibly overwriting files that have been 
customized in your installation of ProductCart. 

Technical Note: All QuickBooks Add-on files start with the prefix “QBK_”, which makes them easily 
recognizable. 

When you are done transferring all the files and folders, log into the Control Panel and update the store 
database as explained in the next section. 
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Updating the database 
Once all the files have been transferred to the Web server, the first step you need to take is to update the 
store database. You MUST update the database immediately after uploading the files, or errors will occur 
in the Control Panel when you attempt to use the QuickBooks Add-on. 

To update the database, go to the following page, where “www.myStore.com” is the domain name of 
your store and “pcadmin” is the name of your admin folder. 

http://www.myStore.com/productcart/pcadmin/QBK_DBUPD.asp 

As mentioned earlier in this chapter, this folder has very likely been renamed with a unique name in your 
installation of ProductCart. If the “productcart” directory is not in the root, adjust the file path 
accordingly. If you are using ProductCart v2.75 and above, you might have also renamed the 
“productcart” folder. If that is the case, adjust the path to the file accordingly. 

When the QBK_DBUPD.asp page is loaded in your browser, the window shown below will be displayed. 

 

Select the database type and execute the update. At the end of the update procedure, you will see a 
confirmation screen indicating that the update was successful. You can now log back into the Control 
Panel and start using the QuickBooks Add-on. 

If you receive an error message, make sure that the database file has read/write permissions assigned to 
the Internet user. If this is not the issue, please submit a support request. 

Note that since the QuickBooks Add-on does not overwrite any existing ProductCart file… 

• There is no way for ProductCart to know that the QuickBooks Add-on files have been uploaded 
to the server, and therefore when you log into the Control Panel after uploading the files you will 
not be automatically redirected to the database update page. You will have to manually enter the 
URL in the browser address field to load the page and initiate the database update. 

• Your ProductCart store version number will not be modified. 

• Your ProductCart navigation will not include a link to the QuickBooks Add-on. To load the 
QuickBooks Add-on, go to the following page (and add it to the Favorites links in your browser), 
where “www.myStore.com” is the domain name of your store and “pcadmin” is the name of your 
admin folder. http://www.myStore.com/productcart/pcadmin/QBK_Default.asp 

Technical note: None of the existing database tables are altered. New tables are added to the store 
database. All of the tables begin with the prefix QBK_. If for any reason you want to remove the current 
installation of the QuickBooks Add-on and restart the installation completely from scratch, you can delete 
all the tables that begin with the QBK_ prefix. All data related to the QuickBooks Add-on will be lost. 
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Step 3 – Importing or Exporting Products 

Choose Your Scenario 
Now that you have installed the QuickBooks Add-on, load the following page in your browser: 
http://www.myStore.com/productcart/pcadmin/QBK_Default.asp 

 

You will be shown the following four scenarios. Choose the one that more closely matches your situation: 

1. New QuickBooks file. New ProductCart store. 
If your online store is new (you have just setup ProductCart and have not yet added any products 
to the store) and your QuickBooks company file is new, skip this section and go directly to Step 4. 

2. New QuickBooks file. Existing ProductCart store. 
If you have already added products to your store, but your QuickBooks company file is new or 
you have not yet added items to its Item List, then you can take the products that are stored in 
your ProductCart database and quickly add them to QuickBooks as Items in the Item List. This can 
not only speed up the setup of your QuickBooks file, but also facilitate the export of orders from 
ProductCart into QuickBooks. If this is your situation, continue onto the next section. 

3. Existing QuickBooks file. New ProductCart store. 
If you have been using QuickBooks, then your Item List probably contains a number of items, 
including the products and services that you are selling. You can export your Item List to create a 
spreadsheet that can be used to import product information into ProductCart using the 
ProductCart Import Wizard. Learn more about how to accomplish this by reading the section 
entitled Importing Products from QuickBooks into ProductCart. 

4. Existing QuickBooks file. Existing ProductCart store. 
Both your ProductCart store and your QuickBooks company file already contain product 
information. If this is the case, go directly to the QuickBooks Add-on Setup Wizard. 

ProductCart – QuickBooks Add-on User Guide - Page 12 of 31 - Copyright © 2001-2005 Early Impact LLC – All Rights Reserved. 



Importing Products from ProductCart into QuickBooks 
Read this section if you have already added products to your ProductCart store, and you wish to use that 
information to populate your QuickBooks Item List.  
Once you are done with the initial setup of your new company file in QuickBooks, you can quickly add 
Items (i.e. the products and services you sell on your online store) to your QuickBooks’ Item List by 
exporting product information from ProductCart. 

To do so, follow these instructions: 

• Load the QuickBooks Add-on start page by entering the following URL in the browser address 
field, where “www.myStore.com” is the domain name of your store and “pcadmin” is the name 
of your admin folder (which has likely been renamed). Add this URL to your browser’s Favorites 
so you can quickly locate it on your next visit. 

http://www.myStore.com/productcart/pcadmin/QBK_Default.asp 

• Select the second scenario and the following window will appear. 

 

• Here is a description of the fields shown on the page: 
o Item Type. When you create an Item in QuickBooks, the first thing you have to 

specify is the “type” of item that you are creating. QuickBooks provides different 
types of items to help you fill out sales and purchase forms. Different properties are 
associated with different item types. Only 3 of the 12 types that QuickBooks 
supports are relevant here. These are the Item Types that your products and services 
can be assigned to. 

 Service. Services you sell. Examples include specialized labor, consulting 
hours, and professional fees. 

 Inventory part. Goods you sell and for which you track inventory. Examples 
include any product you buy and resell. 

 Non-inventory part. Goods you sell, but for which you don’t track inventory. 
Examples include products that you don’t buy (e.g. software you designed). 

o Income Account. The newly created items will be assigned to the income account 
you specify. The income accounts that are most frequently used for products and 
services, and that QuickBooks creates by default when you create a new company, 
are "Sales:Merchandise" and "Sales:Service". Note that a colon separates the sub-
account ("Merchandise") from the main account ("Sales"). 
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• Note that if a product is set up as Non Taxable in ProductCart, the Item created in 
QuickBooks will also be a non taxable item. The Tax Code field in the Edit Item window will 
show the value “Non” (which is the default value for non-taxable items – you might have 
changed this value in your QuickBooks company file). 

• Click on the Submit button to continue. ProductCart will create a *.IIF file that you can 
download to your computer and import into QuickBooks. 

 

• If you are running the 2004 version of QuickBooks, before proceeding make sure to update 
the software to the latest version using the built-in update feature. To do so, select File > 
Update QuickBooks > Update Now. DO NOT import items or orders into QuickBooks unless 
you are running the latest version of QuickBooks 2004. This is important because a known 
bug that affected the import of items in earlier versions of QuickBooks 2004 would cause 
your product information not to be correctly imported. 

• Always back up your QuickBooks company file before importing any *.IIF file, as this step 
cannot be undone. 

• You can now proceed with the import. Open your QuickBooks company file, and select File 
> Import > IIF Files… Locate the *.IIF you exported from ProductCart and click Open. 

• You should see all of your imported products and services in your Item List. You can now 
return to ProductCart and proceed with the QuickBooks Add-on Setup Wizard (first time 
use) or continue using the Add-on. 

Importing Products from QuickBooks into ProductCart 
If you have an extensive Item List in your QuickBooks company file and you are just getting started using 
ProductCart, there are steps you can take to speed up the process of adding products and services to your 
online store database by using the information that you have already entered in QuickBooks. 

ProductCart includes a feature-rich Import Wizard that allows you to enter all kinds of product and 
category information into your store database in just a few clicks. For more information about using the 
Import Wizard, make sure to consult the ProductCart User Guide: there is a section entirely dedicated to 
importing products into your store using the Import Wizard. 

The steps to importing product information from QuickBooks into ProductCart are as follows: 

• Open your QuickBooks company file, then select Reports > List > Item Listing 
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• QuickBooks will create a report that lists all the items from your Item List. Click on the Modify 
Report button to show additional information (columns) or hide fields that are currently shown. 

• When you are done, select Export > A new Excel Workbook. If your version of QuickBooks does 
not support exporting directly to Microsoft Excel, then export to a comma separated file, which 
can then be easily imported into Excel. 

• Unfortunately, the Excel spreadsheet that will be created is not in a format that is immediately 
compatible with the ProductCart Import Wizard. You will need to remove empty columns, remove 
rows other than those containing item information or the column headers, and more. Refer to the 
ProductCart User Guide for detailed information on formatting an Excel spreadsheet for use with 
the ProductCart Import Wizard.
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Step 4 – Running the Setup Wizard 

Overview 
Before you start the QuickBooks Add-on Setup Wizard, make sure you have done the following: 

1. You have added the necessary items to the QuickBooks Item List as described in Step 1 of this 
User Guide. It’s important that you take this step before starting the Wizard. 

2. You have added product information to both your ProductCart store (i.e. the store database 
contains products) and/or your QuickBooks company file (i.e. the Item List contains items). This 
is important if you wish to synchronize product information between QuickBooks and 
ProductCart. 

This Setup Wizard will take you through the following steps: 

1. Import customers from QuickBooks into ProductCart 
You can import customer information from QuickBooks to ProductCart, if any. You can then 
synchronize some or all of the imported customer accounts with customers that already exist in 
your store database. If you do this, when you export orders from ProductCart to QuickBooks 
customer accounts will be correctly recognized and sales will be assigned to the corresponding 
customers. Some businesses use a generic customer account in QuickBooks for all or most of 
their online orders (e.g. "Online Sales"). If that is the case, you can setup ProductCart to 
accommodate this scenario.  

2. Import your QuickBooks "Chart of Accounts" & "Item List" 
This information will then be used to map products and miscellaneous items. 

3. Synchronize products 
You will be able to map all or some of your products to items imported from the Item List. 

4. Synchronize other items 
Finally, you will be able to synchronize miscellaneous invoice line items such as shipping charges, 
handling fees, discounts, etc. so that they are assigned to the correct accounts in QuickBooks. 

Importing & Synchronizing Customers 
The QuickBooks Add-on contains a feature that allows you to synchronize customer accounts that exist 
both in your QuickBooks company file and in your store database. When a customer account is 
synchronized, all orders placed by that customer are assigned to the corresponding customer account in 
QuickBooks when those orders are exported from ProductCart. 

You can map or synchronize customer accounts at any time. You don’t have to map them (or map them 
all) during the initial Setup Wizard. If one or more customer accounts are not mapped to their 
corresponding accounts in your QuickBooks file, you will be asked to define a generic customer account 
that orders placed by those customer will be assigned to. 

If you have customer accounts setup in QuickBooks and you also have customer accounts in your online 
store, then we recommend that you import them into ProductCart. If you don't have any customer 
accounts in your QuickBooks file, or if you only use a generic customer account (e.g. "Online Sales") for 
all your Internet orders, then choose not to import them at this time. 

If you choose to Import customer accounts from QuickBooks, you will first need to export this information from 
QuickBooks. To do so, follow these instructions: 



1. From the File menu, choose Open Company. Select the correct company and click OK.  

2. From the File menu, click Utilities, and choose Export. 
If you are using QuickBooks 2004, simply choose 
Export from the File menu, and then choose Lists to IIF 
Files...  

3. In the window that appears, select Customer List and 
click OK.  

4. Enter a name for the file. Make sure it has the .IIF file 
extension, which is added by default.  

5. Click Save to export the file. 

6. You can now upload the file to ProductCart. Use the Browse button to locate the file. 

 

ProductCart will ask you to confirm whether you’d like to assign customers to a generic account or map 
individual customers. As mentioned before… 

• You can have all customers in ProductCart exported to a generic customer account in 
QuickBooks. In this scenario, all orders are assigned to a generic customer such as "Online Sales", 
which you can specify. You can decide to map individual customers at any time. The generic 
customer account could be one of the accounts that you have just imported, or you could create a 
new one.   

• You can map one or more customers in ProductCart to individual customer accounts in 
QuickBooks. In this scenario, the orders placed by the customers that have been synchronized 
with accounts in QuickBooks are assigned to those accounts when imported into QuickBooks. 
Any other order is assigned to a generic account such as "Online Sales". This could be one of the 
accounts that you have just imported, or you could create a new one. 

If you decide to map all customers to one account, you can skip the following paragraph. 

Synchronizing Individual Customer Accounts 
ProductCart allows you to create a direct relationship between one or more customers in your store 
database and one customer account in your QuickBooks company file. To do so, ProductCart will show 
you a window that is organized as follows: 

• At the top there is a drop-down menu that allows you to order the customers listed on the left 
side by company name, first name, or last name. 

• On the left side, all of your ProductCart customers are listed. 
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• In the middle of the page there are two buttons that allow you to move customers listed on the 
left side to the right side of the page. 

• At the bottom there is a drop-down that lists customer accounts that you have just imported from 
QuickBooks. When you select an account and click on the Continue button, ProductCart creates a 
relationship between the customer or customers listed on the right side of the page and the 
customer account listed at the bottom. The system will show you a confirmation message 
indicating that the selected customer accounts have been mapped. 

 

• You can go on creating new relationships between customers. The process of mapping customer 
accounts is always the same: 

o Select one or more customers from the left side column. You can map more than one 
store customer to an individual QuickBooks customer account: for example, this can be 
useful if more than one representative from the same company has established an 
account on your online store. 

o Move them to the right side column by clicking on the Add button. The Remove button 
performs the opposite task. 

o Select a QuickBooks customer account from the drop-down at the bottom of the page. 
o Click on Continue. 

 

When you are done mapping individual customers, click on Finished. ProductCart will determine whether 
all of your store customers have been assigned to a QuickBooks customer account. If the answer is no, 
the system will ask you to pick a generic customer account to be used for all unmapped customers (e.g. 
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“Online Sales”). All orders placed by customers other than those that have been individually mapped will 
be assigned to this generic customer account. 

Note that if you have a large number of customers, mapping all of them to the generic customer account 
make take several seconds. Wait while the script is executing. When all customers have been mapped, you 
will be automatically redirected to Step 3 of the Setup Wizard, if you are running the Wizard. 

You can edit your customer mappings at any time, changing or removing existing relationships, or 
creating new ones. If you create new customer accounts in QuickBooks, you can import them into 
ProductCart. 

Synchronizing to a Generic Customer Account 
During the QuickBooks Add-on Setup Wizard, if you select Do not import customer accounts at this time, 
ProductCart will take you through a different set of steps. In this scenario, you don’t have any 
QuickBooks customer accounts to which you can map existing store customers. Therefore, ProductCart 
will ask you to create at least one account. 

• You can create one or more customer accounts. 
• You need to create at least one customer account. This is the generic customer account that will 

be used for all orders placed by customers that have not been individually mapped to existing 
customer accounts in your QuickBooks company file. If you decide not to map any customers to 
individual customer accounts in your QuickBooks company file (e.g. there are no customer 
accounts in your accounting file yet), all orders will be assigned to this generic account. 

• If the generic customer account that you specify here does not exist in your QuickBooks 
company file, a new one will be created. 

 

Now that you have created one or more new customer accounts using the Setup Wizard, ProductCart will 
ask you whether you want to map all or some of your customer accounts to any of the individual accounts 
that you have imported or created. You have two options, as mentioned before. 

One is map one or more customers in ProductCart to individual customer accounts in QuickBooks and 
the remaining, unmapped customers to a generic customer account. This option is described in the 
previous section of this User Guide. 

The other option is to map all of your store customers to a generic customer account in QuickBooks, 
such as "Internet Sales". In this scenario, all orders are assigned to this generic customer. On the window 
that is shown to you, simply select the account that you would like to use from the drop-down menu and 
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click on Submit. At any time when using the QuickBooks Add-on you will be able to change this setting 
and decide to map one or more store customers to individual QuickBooks customers. 

 

Importing & Synchronizing Products and Items 
The QuickBooks Add-on Setup Wizard will now ask you to import your Chart of Accounts and Item List 
into ProductCart so that your products, shipping charges, discounts, etc. can be properly mapped to their 
corresponding accounts in your QuickBooks company file. 

If you haven’t already done do, make sure to first review the section of this User Guide entitled: Adding 
Necessary Items to the QuickBooks Item List. 

 

After adding the required items to your Item List, follow these instructions to export the lists and import 
them into ProductCart: 

1. From the File menu, choose Open Company. Select the company containing the lists you want to 
transfer and click OK.  

2. From the File menu, click Utilities, and choose 
Export. 
(QuickBooks 2004 users, choose Export from the 
File menu, then select Lists to IIF Files....) 

3. In the window that appears, select both Chart of 
Accounts and Item List and click OK.  

4. Enter a name for the file. Make sure it has the .IIF 
file extension, which is added by default.  

5. Click Save to export the data. 
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Now that you have exported the two lists, use the Browse button to locate the IIF file and click Continue... 
to upload it. ProductCart will save the information to the database and then take you to the following 
screen, where you can decide whether to manually synchronize some or all of your products to the 
corresponding items in your Item List or not. 

 

If you choose not to synchronize your products and items, please note the following important 
observations about how product information is treated when orders are exported from ProductCart into 
QuickBooks. When orders are imported into QuickBooks: 

• If a product that is part of the orders has not been mapped to an item in your QuickBooks 
company file, but it matches an item in the Item List, a new item will not be created. You can 
match exported products to existing items in the Item List using either the SKU (part number) or 
the product name. This field is matched to an item's Item Name/Number field. 

• If a product that is part of the orders does not match an item in the Item List, a new item will be 
created and assigned to the income account that has been associated with unmapped products 
using the window shown below. 

The drop-down menu lists all (and only) income accounts that are part of the Chart of Accounts 
imported from your QuickBooks company file. Select an income account and the product field 
that should be used to match existing items. You can either use the SKU (part number) or the 
product name. This field is matched to an item's Item Name/Number field. 

Click on the Apply button to apply these settings and continue to the next screen. 
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If you choose to synchronize your products and items, ProductCart will show you a series of 
pages where existing products in your store database are listed along with a drop-down menu listing 
imported items from your QuickBooks Item List. 
By default, products are sorted by name and 20 products are shown per page. You can change the 
number of products shown and the order in which they are shown. 

 

ProductCart will try to automatically find matches between each of the imported items and each of the 
products that are already in your store database (auto-mapping). The system will do so by comparing  
either the Item Name/Number field in the exported QuickBooks Item List with the product SKU in your 
ProductCart database or the Description field in the Item List with the product Name. You can use either 
variable by selecting it at the top of the page. 

Note that if you export products from ProductCart to QuickBooks to create a new Item List (i.e. this is a 
new QuickBooks company file and its Item List is empty) or to add new products to an existing Item List, 
when you import the Item List back into ProductCart, all products will be automatically mapped as their 
names will match by definition (the product names are definitely the same since the new items were 
created by exporting those products from ProductCart). 

This is certainly a recommended course of action if you don’t currently have product information stored 
in your QuickBooks company file. You can at once populate the Item List and map all the items to the 
products stored in your ProductCart database. 
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Let’s return to the product mapping page. If a match is not automatically found, you can manually map a 
product in your store to an item from the Item List by choosing an item from the drop-down (manual 
mapping). 

When you are done, click on the Apply Mappings buttons. If there are other products that can be mapped, 
ProductCart will show you a new page.  

At any time you can click on Assign remaining products to a default Account to stop mapping individual 
products, and assign all unmapped products to a generic income account that will be used if and when 
new items are created when orders are exported to QuickBooks (see earlier in this chapter for more details 
on when a new item is added to the Item List upon exporting orders to QuickBooks). 

 

Choose a default income account from the drop-down menu and click Continue. The remaining 
products will be assigned to the selected account and you will be shown a window that summarizes 
your product mappings, which is shown below. 

 

You can access this window at any time from the QuickBooks Add-on start page by clicking on 
View/Edit Product Mappings. 
At the top of the page ProductCart will remind you of how many products are currently not 
assigned to individual items (if any). You can assign these products to individual items in your 
QuickBooks Item List at any time, if you wish to do so. 
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The central part of the page shows existing product mappings: your store products are shown on the 
left and the items that they have been mapped to are shown on the right. You can easily change the 
number of products shown on the page and the order in which they are sorted by using the 
corresponding features at the top of the page. 

• To change a current product mapping: check one or more products on the page using the 
check box on the left side. Select an item from the drop-down, and then click on Update 
Mappings. 

• To remove a current product mapping: simply click on the Remove button on the right side. 

• To remove all product mappings: click on the Remove all product mappings at the bottom of the 
page. All current product-time relationships will be removed. You will then be able to either 
assign these products to a generic income account and let QuickBooks match them to 
existing items in the Item List, or manually map them again (e.g. you are going to import a 
heavily modified Item List and wish to start from scratch). Be careful as this action cannot be 
undone. 

When you are done, click on Back to the QuickBooks Add-on start page to return to the welcome screen, 
which is shown below. 

 

Synchronizing Miscellaneous Items 
The final step before being able to export orders from ProductCart into QuickBooks is to map a 
few remaining items from the Item List, such as discounts, taxes, and shipping & handling charges. 
You should be taken to the page shown below during the Setup Wizard. If not, or at any other time, 
click on View/Edit Other Item Mappings on the QuickBooks Add-on start page. 
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If you have correctly followed the instructions listed in the section of this User Guide entitled Adding 
Necessary Items to the QuickBooks Item List, you will be able to quickly map the ProductCart items 
listed on this page to the corresponding items in your QuickBooks Item List. If you have not yet reviewed 
that section of this User Guide, please do so now. 

Listed on the Miscellaneous Account Mappings page are items that may appear on the orders that your 
customers place on your online store. Some of them may not apply to your store. For example, you may 
or may not be using the Reward Points system in your ProductCart-powered store. Regardless of whether 
you are using any or all of these features, you need to establish a relationship between them and their 
QuickBooks counterparts. 

• Coupon/Gift Certificates. These are discounts, electronic coupons or gift certificates used on 
your store. If you are using the ProductCart Gift Add-on, note that redeemed gift certificates use 
this invoice line item. Choose one of the items shown in the drop-down menu. Note that only 
Item List items whose Type was set to Discount will be shown in the drop-down menu. 

• Reward Points: Same as above, but this item will carry the amount deducted from the order when 
customers use Reward Points against the order total. 

• Payment/Processing Fees: This is the fee that you may charge when customers select a certain 
payment option. Choose one of the items shown in the drop-down menu. Note that only Item 
List items whose Type was set to Other Charges  will be shown in the drop-down menu. 

• Shipping Charges: This is the delivery charge included in the order (if any). Choose one of the 
items shown in the drop-down menu. Note that only Item List items whose Type was set to Other 
Charges  will be shown in the drop-down menu. 

• Handling Fees: This is the handling fee included in the order (if any). This is the fee that you may 
charge when customers select a certain payment option. Choose one of the items shown in the 
drop-down menu. Note that only Item List items whose Type was set to Other Charges  will be 
shown in the drop-down menu. 

• Taxes: Depending on whether your store charges one or multiple sales taxes, you will map this 
item to one or more items in your Item List. You need to map this item even if your store does not 
collect sales taxes on any orders. For more information, please see the Configuring QuickBooks 
section of this User Guide. Choose one of the items shown in the drop-down menu for each of 
the taxes charged on your store. Note that only your Sales Tax Items will be shown in the drop-
down menu. 

When you are done, click on the Submit button, and then return to the QuickBooks Add-on start page. 
You are now ready to export orders from ProductCart to QuickBooks. Before you do so, always 
remember to back-up your QuickBooks company file, so that you may quickly restore your accounting 
books if anything goes wrong during the import. 
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Step 5 – Exporting Orders to QuickBooks 

Overview 
Now that you have completed the Setup Wizard, you are ready to start exporting orders from 
ProductCart and import them as invoices or sales receipts into your QuickBooks company file. Before 
you do so, take a moment to save a backup version of your QuickBooks file. In fact, you should always 
make sure to back up your QuickBooks company file before importing orders from ProductCart. 

When you import an IIF file (the type of QuickBooks file that orders are exported to) into QuickBooks, 
the action cannot be undone. Undoing an import can be quite time consuming, especially if you are 
importing a large number of orders. The only way to undo the import would be to manually delete each 
invoice or sales receipt that was created by QuickBooks when the IIF file was successfully imported. 

Exporting Orders 
On the QuickBooks Add-on start page, click on Export Orders to QuickBooks to begin the process of 
exporting orders from ProductCart On the first screen, configure the following settings: 

 

• Customers. Indicate whether you would like to export orders from an individual customer or all 
customers. Your store customers will be matched up with your QuickBooks customer accounts 
according to the customer mappings that you have previously created. For more information on 
how to synchronize customer accounts, see Importing & Synchronizing Customers. 

• Date Range. Specify a date range. Orders placed on both the From and To dates are included in the 
export. If you leave any of the fields empty, they will automatically be filled with today’s date. If 
your store receives a large number of orders every day, we recommend that you reduce the data 
range so that fewer than 100 orders are exported at a time. Otherwise, the ASP script that creates 
the export file might time out. Depending on how much information is included in each order, 
and many other factors such as the performance of your Web server, SQL server (if any), etc., you 
might be able to export a much greater number of orders. If you receive a time-out error, try 
reducing the date range. 

• Status. Specify which orders should be included in the export file. If you leave all three check 
boxes unchecked, all orders will be exported. Typically, you will export orders that have been 
processed and/or shipped. Incomplete, cancelled, and/or returned orders are always excluded fro, 
the export. 
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When you return to this screen after having exported orders from ProductCart, you will also be prompted 
to select whether previously exported orders should be included in the new export file or not. ProductCart 
will remember this setting for future use. Select Yes if you only want to export new orders. Select No if you 
want to include orders that have previously been exported. In most cases, you will want to only export 
new orders, and therefore will select Yes. 
Click on Continue to proceed to the following page and configure a series of other options that affect how 
orders are exported. 

• Import Type. Orders can be imported into QuickBooks as either Invoices or Sales Receipts. You can 
find detailed information about the difference between Invoices and Sales Receipts in your 
QuickBooks manual or online help. Overall, the main difference is that when you enter an 
invoice, you are populating your Account Receivables with a new transaction, which is then removed 
from Account Receivables when you Receive Payment on the invoice. The idea is that you typically 
create an invoice when you are not receiving payment at the time the transaction occurs. When 
you enter a sales receipt, instead, QuickBooks never places the transaction in Account Receivables as 
it assumes that you are receiving payment on it at the same time the transaction occurs (there is no 
payment to receive in the future). Therefore, as a rule of thumb: 

o Use sales receipts if you receive payment on the order at the time the order is placed or 
processed. This is often the case with Internet orders, as well as with call-in or walk-in 
orders in a retail environment. 

o Use invoices in all other cases. 

o Accounting-wise, you can do either one and you will not be making a “mistake”. It’s 
more of a productivity issue. If you use invoices, there is one more step for you to take 
(Receive Payments) which is skipped if you use sales receipts. 

• Invoice Number. Unlike when you create an invoice or sales receipt in QuickBooks, when you 
import orders into QuickBooks the program does NOT automatically number the invoice or 
sales receipt. You can either manually enter invoice numbers after you have finished importing 
your orders, or you can have your import file automatically assign an invoice number. 

To do this, open QuickBooks and look up the last invoice number. Then come back to 
ProductCart and select Yes. A new section of the page will be displayed. In the Start with this invoice 
number field, enter the number that you want the first new invoice or sales receipt to have, not the 
number of the last invoice or sales receipt that appears in your QuickBooks file. 

The next time you export orders from ProductCart, this field will be pre-filled with a number that 
is equal to the last invoice or sales receipt number used in the last import, plus one. If you have 
not added other invoices or sales receipt, you can use this number. But if you have manually 
added other invoices or sales receipt in QuickBooks, you should look up the correct number there 
and replace the number in the field with the right one. 

• Transaction Date. The transaction date is the date that is placed on the invoice or sales receipt. 
You may use the actual order date or the current date. If you wish to use the order date, select Yes. 

• Other Settings. 

o Marking transactions as “Cleared”. Normally, you clear a transaction when you reconcile 
it with your bank statement. This is to ensure that your QuickBooks records agree with 
the checking, savings, credit card statements, etc. that you regularly receive. Therefore, 
you will typically not want your transactions to be marked as Cleared when they are 
imported, but rather clear them yourself when reconciling accounts in QuickBooks. For 
more information, consult the QuickBooks User Guide or Online Help. 
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o Marking your invoice “To be Printed”. This setting doesn’t affect the way invoices or 
sales receipts are created, but rather can save you some time if you want to be able to 
print all imported invoices or sales receipts with one click. If you plan to print them after 
you import them into QuickBooks, then mark them To Be Printed. When you do so, the 
To Be Printed check box in the bottom left corner of your invoice or sales receipt will be 
checked. To print all invoices or sales receipts for which this option has been checked, 
select File > Print Forms… > Invoices or Sales Receipts. All the invoices or sales receipts 
marked To Be Printed will appear in the window that is displayed to you. 

 

o Include “Shipping Method” and “Shipping Date”  information. You can elect to include 
or not include shipping information on your invoice or sales receipts. Note that this 
setting does not refer to the actual shipping charges and handling fees that are 
automatically included as line items on the invoice or sales receipt, if any. Rather, this is 
the information that is added to the Via field on your invoice or sales receipt. The Shipping 
Date, if included, is added to the Ship field. 
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o Add details to the Memo field. This feature allows you to add the following information 
to an invoice or sales receipt. 

 Customer E-mail (<CEMAIL>) 

 Order Number (<ORDNUM>) 

 Referrer (<REFER>) 

 Payment Type (<PAYTYPE>) 

To include this information in the Memo field, enter any of the corresponding tags: 
<CEMAIL>, <ORDNUM>, <REFER>, and/or <PAYTYPE>. For example, in the 
input field you could enter: 

Customer e-mail: <CEMAIL>. Online store order number: <ORDNUM>. Payment method 
used for the order: <PAYTYPE>. This order was referred by: <REFER>. 

Note that general customer details (e.g. name, company name, billing & shipping address, 
etc.) will be included in the Bill To and Ship To fields on the invoice or sales receipts. 

o Include customer comments. Finally, you can have ProductCart export any comments 
that a customer might have added to their order. These are the comments that customers 
can add to an order by filling out the Comments field during checkout. 

Click on the Submit button to generate the export file. Note that depending on the amount of orders that 
you are exporting, this process could take some time. If you receive an error message that indicates that 
the script timed out, try reducing the date range so that you are exporting a smaller amount of orders. 

Importing Orders into QuickBooks 
When ProductCart has completed the export, you will receive the following message: You have successfully 
exported order information to the file: "qbIvoice.iif". To download this file, don’t click on it as most browsers will 
show the content of the file directly to you rather than downloading it to your computer. Instead (in 
Internet Explorer): 

• Right click on the download icon and choose "Save Target As..." from the context menu. 

• Save the *.IIF file to your desktop. In some cases, the Web server may not recognize this file 
format and return a "404 File Not Found" error. If that is the case, you will need to download 
your file via FTP. The file is located in the "pcadmin/qbk_export" folder.  
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Once the file has been downloaded to your desktop, start QuickBooks and select File > Import > IIF Files. 
QuickBooks will import the selected file and create a number of invoices or sales receipts that 
corresponds to the number of orders you have exported from ProductCart. 

As mentioned earlier in this chapter, make sure you back up your QuickBooks company file before 
importing this IIF file. Importing an IIF file cannot be undone. The only way to "undo" the import is to 
manually remove all invoices or sales receipts that are created when the file is imported, which can be a 
very tedious and time consuming task. It is much easier and faster to restore a previously backed up 
company file. 

Frequently Asked Questions 
 

What if I have thousands of products in my ProductCart store database? 

In this case you probably will not want to synchronize product information between QuickBooks 
and ProductCart. The QuickBooks Add-on allows you to assign products that have not been 
mapped to individual items in your Item List to a generic income account in your Chart of Accounts.  
When you export orders from ProductCart, the following will happen: 

• If a product included in an order does not match an item in the Item List, a new item will be 
added to the list. The item will be assigned to the generic income account mentioned above. 
This new item will be used on the invoice or sales receipt created for the imported order. 

• If a product included in an order matches an item in the Item List, a new item will not be 
created and the existing item will be used. 

 

I added new products to my ProductCart database. What is the best way to map them to items in 
QuickBooks? 

We recommend taking the following steps: 

• If those products are not in your QuickBooks Item List, export them to QuickBooks using the 
product export feature. When you do so, make sure that you select the same Item Type and Income 
Account used during previous exports, or used by the majority of items listed in your Item List. 

• Now export the newly updated Item List and Chart of Accounts to an *.IIF file 

• Return to the QuickBooks Add-on start page and select Import Chart of Accounts & Item List From 
QuickBooks. 

• By definition, the name of the imported items will match the name of the products that you had 
exported from ProductCart, and therefore the auto-mapping feature will automatically map them 
for you. So all you need to do is confirm the mappings, and you are done. 
 

The export process is taking a log time, and sometimes it times out. What can I do? 

Try reducing the date range so that fewer than 100 orders are exported at a time. Otherwise, the ASP 
script that creates the export file might time out. Depending on how much information is included in each 
order, and many other factors such as the performance of your Web server, SQL server (if any), etc., you 
might be able to export a much greater number of orders. 
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Some of the items on my invoices are truncated. Why? 

The customer name and job name (Customer:Job field on the invoice or sales receipt) can each contain a 
maximum of 41 characters. If you export an order to QuickBooks where the customer’s company name 
had more than 41 characters, the company name will be truncated at 41 characters. Similarly, the name of 
the shipping service used for the order (Ship Via field on QuickBooks invoices) has a limit of 15 
characters. ProductCart will truncate all names to 15 characters when exporting orders. 
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